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Safety considerations

Some reagents and samples used with Waters instruments can pose chemical, 
biological, or radiological hazards. Be sure you are aware of the potentially 
hazardous effects of all substances you work with. Always follow Good 
Laboratory Practice, and consult your organization’s safety representative for 
guidance.

When you develop methods, follow the “Protocol for the Adoption of Analytical 
Methods in the Clinical Chemistry Laboratory,” American Journal of Medical 
Technology, 44, 1, pages 30–37 (1978). This protocol addresses good operating 
procedures and the techniques necessary to validate system and method 
performance.

Instrument-specific safety considerations
Refer to MassLynx and FractionLynx online help and operator’s guides for the 
individual modules of the Waters AutoPurification™ System. 

Safety advisories
Consult Appendix A for a comprehensive list of warning and caution 
advisories.

Operating this device

When operating this device, follow standard quality control procedures and 
the guidelines presented in this section.
iii
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Intended use
Waters® designed the Waters AutoPurification System to purify compounds 
by UV/Vis detection and mass spectrometry. 

Calibration
To calibrate HPLC systems, follow acceptable calibration methods using at 
least five standards to generate a standard curve. The concentration range for 
standards should cover the entire range of quality-control samples, typical 
specimens, and atypical ones.

To calibrate mass spectrometers, consult the calibration section of the 
operator’s guide of the instrument you are calibrating.

Quality control
Routinely run three quality-control samples that represent subnormal, 
normal, and above-normal levels of a compound. Ensure that quality-control 
sample results fall within an acceptable range, and evaluate precision from 
day to day and run to run. Data collected when quality control samples are out 
of range might not be valid. Do not report these data until you are certain that 
the instrument performs satisfactorily.

Warning: Although some of the modules in the AutoPurification 
System might carry IVDD labels, the system as a whole is not 
intended for clinical use. 
iv
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1 System Overview

Waters® AutoPurification™ Systems are composed of chromatography 
instruments designed to purify your samples. FractionLynx™ software 
controls these purification systems, which use various types of 
compound detection, fraction triggering, and fraction collection 
capabilities. Compound detection is achieved by combinations of 
ultraviolet (UV) absorbance detectors, photodiode array (PDA) detectors, 
evaporative light-scattering detectors (ELSD), and mass spectrometers 
(MS). 

Contents:

Topic Page

Capabilities and configurations 1-2

System components 1-7

Options 1-14
1-1
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Capabilities and configurations

Waters AutoPurification Systems purify samples using various detectors: 
absorbance, mass spectrometry, and evaporative light-scattering. The most 
common systems are UV-directed or MS-directed. 

In a UV-based purification system, the sample is separated by the HPLC 
column, and fractions are collected according to specific wavelengths selected 
by the user. After collection, the AutoPurification System can inject the 
fractions and further analyze the results. 

In a mass-based AutoPurification System, compounds are separated by the 
preparative HPLC columns. They then flow into a mass detector for advanced 
confirmation, compound characterization, and appropriate triggering of 
fractions. Fractions are then collected into microplates or tubes according to 
molecular weight, UV absorbance, timed event, or a combination of factors. 

To minimize user intervention and maximize unattended operation, the 
system monitors mobile phases, makeup solvents, and waste levels.

UV-directed purification
The Waters UV-directed system uses the UV detector as its primary detector. 

Solvent flows from the 2545 binary gradient module to the 2767 sample 
manager analytical or preparative injection valves, and then to the 
corresponding columns in the system fluidics organizer. Analytical flow is 
directed to a 3-column selection valve, and preparative flow through a 10-port 
selection valve and prep column(s). The backpressure regulator and UV 
fraction manager are connected between the UV detector and the fraction 
collection valve of the 2767 sample manager or optional Waters Fraction 
Collector III.
1-2 System Overview
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UV-directed system

Sample and solvent flow through the UV-directed system: 

UV fraction manager

The UV fraction manager provides the delay time between the detector flow 
cell and the fraction collector diverter or collection valve. One of four fixed 
channels provides for the proper delay time based on column and flow rate. 

PC with MassLynx and 
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System fluidics 
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Bottle tray 

Solvent 

Injection valves 
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System 
Fluidics 
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UV Fraction 
Manager 

Collection vials 
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Dual-inlet flow cell

For UV-directed systems, a single-channel, dual-inlet flow cell is available for 
both the Waters 2487 UV and 2996 PDA Detectors. These flow cells are 
compatible with analytical or preparative flow rates ranging from 0.5 to 
150 mL/min. 

MS-directed purification
The Waters MS-directed autopurification system uses the Waters 3100 Mass 
Detector as its primary detector. 

MS-directed system

PC with MassLynx and 
FractionLynx software

2767 sample 
manager

2545 binary 
gradient module 

System fluidics 
organizer

3100 mass 
detector 

2996 PDA 
detector

Bottle tray515 makeup pump
(not shown)
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Sample and solvent flow through the MS-directed system: 

MS-directed systems require a flow splitter to direct a small amount of the 
total sample purification flow to the detectors. The splitter fits into the front of 
the system fluidics organizer and generates a split ratio of incoming solvent 
flow. You must select the appropriate flow splitter for the flow rate and 
application. 

The primary flow splitter divides the prep flow so that 99.9% goes to the 
fraction collector and 0.1% is carried by the 515 makeup pump to the detector 
for analysis. 

A secondary flow splitter (or tee) typically sends 20% of the flow to the mass 
detector and 80% of the flow to the UV detector.

The pump control module in the system fluidics organizer can control up to 
three 515 pumps. The pump control module communicates over an IEEE-488 
cable connection and interfaces with the workstation using the GPIB 
communication protocol.
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Warning: Stacking hazard. Stacking configurations for system instruments 
must meet all relevant safety requirements and performance standards. 
Each base module of the Waters AutoPurification System, whether it be the 
system fluidics organizer, 2545 binary gradient module, or 3100 mass 
detector, can physically support no more than two accessory modules stacked 
on top of it. Stacked accessory modules can include the Waters 515 pump, 
photodiode array detector, evaporative light-scattering detector, or 
dual-wavelength absorbance detectors. 
Waters neither recommends nor supports stacking configurations that differ 
from this model. Such nonconforming configurations would invalidate 
warranties and shift responsibility for operator safety and system 
performance to the user. 
1-6 System Overview
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System components

Solvent delivery
The software coordinates all solvents that comprise the gradient flow stream. 
The gradient table and flow rate automatically adjust to compensate for 
at-column-dilution and mobile phase modifiers (optional features). 

Waters 2545 Binary Gradient Module

The Waters 2545 Binary Gradient Module (BGM) is a high-pressure binary 
gradient pump, the primary solvent delivery device for the system. It can 
deliver solvent at flow rates from 0.5 to 100 mL/min at a maximum of 
6000 psi, or flow rates from 100 to 150 mL/min at a maximum of 5000 psi. 

The 2545 BGM has four solvent inlet lines (A1, A2, B1, and B2). You can select 
two lines at one time for chromatographic runs.

• A1 and B1

• A2 and B2

• A1 and B2

• A2 and B1

See also: Waters 2545 Binary Gradient Module Operator’s Guide.

Waters 515 HPLC Pump

The 515 HPLC pump, in conjunction with a pump control module, is required 
as a “makeup” pump. The pump dilutes the sample from the primary splitter 
and carries the flow to the detectors. Additional 515 pumps can be used for 
at-column dilution or mobile phase modifier addition. 

See also: Waters 515 HPLC Pump Operator’s Guide and “At-Column Dilution 
Application Notes” (part number 71500078010), which is available at 
www.waters.com.
System components 1-7
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Sample handling

Waters 2767 Sample Manager

The 2767 sample manager, injector, and collector is a high-capacity sample 
processing system for managing sample injections.

The 2767 sample manager operates under MassLynx software control through 
an RS-232 serial port.

During operation, the sample flows through the sample manager to columns 
and other instruments and devices in the system. Then it flows back to the 
sample manager for fraction collection. 

See also: Waters 2767 Sample Manager Operator’s Guide.

System organizer

Waters System Fluidics Organizer 

The system fluidics organizer (SFO or FO) houses the columns, the pump 
control module, and either the primary fraction flow splitter for MS-directed 
systems or a UV fraction manager for UV-directed systems.

An Ethernet switch in the system fluidics organizer serves as a connection 
point for the networked modules. Standard Ethernet cables provide 
connectivity between compatible modules and the Ethernet switch.

The system fluidics organizer communicates with the system through a 
rear-panel Ethernet connection. Its three electrically activated rotary valves 
work as follows. 

• The 6-port analytical-to-prep valve provides switching between 
analytical and preparative analyses. 

• An 8-port valve diverts flow to one of three analytical columns. 

• The 10-port column selection valve provides the option to switch 
between two preparative columns and/or plumb an additional pump into 
the system to regenerate columns. 

Warning: To prevent injury, use the 2767 sample manager with its safety 
shield in place.
1-8 System Overview
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Sample detection
The AutoPurification System can control multiple detectors for fraction 
triggering, sample confirmation, and waste detection.

Waters Photodiode Array Detector 

The photodiode array detector (PDA) is an ultraviolet/visible light (UV/Vis) 
spectrophotometer with 12 diodes and an optical resolution of 1.2 nm per 
diode. Its operating wavelength ranges from 190 to 800 nm. 

Mass-directed systems use the standard analytical flow cell. UV-directed 
systems typically use a 2996 AutoPurification flow cell, whose shorter path 
length helps keep preparative peaks on scale. 

See also: Waters 2996 PDA Detector Operator’s Guide. 

Waters Tunable UV Detector

The 2487 UV detector is for analytical and preparative runs. It operates from 
190 to 700 nm and monitors absorbance at one or two discrete wavelengths. 

Mass-directed systems use the standard analytical flow cell. UV-directed 
systems typically use a 2487 AutoPurification flow cell, whose shorter path 
length helps keep preparative peaks on scale. 

See also: Waters 2487 Dual Wavelength Absorbance Detector Operator’s 
Guide. 

Waters Evaporative Light Scattering Detector 

The evaporative light scattering detector (ELSD) measures the light scattered 
by analyte particles after the mobile phase evaporates from the sample. This 
generic method of detection is compatible with virtually all modes of 
chromatography. It is particularly useful for molecules without UV/Vis 
chromophores and those that do not ionize. 

See also: Waters 2420/2424 Evaporative Light Scattering Operator’s Guide.

Waters 3100 Mass Detector

The 3100 mass detector, a mass spectrometer used for analytical and 
preparative runs, measures the mass-to-charge ratio (m/z) of individual 
ionized molecules. The instrument operates from 22 to 2000 Da.

See also: Waters 3100 Mass Detector Operator’s Guide.
System components 1-9
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Software control

MassLynx software and the FractionLynx Application Manager

The MassLynx software and FractionLynx Application Manager software 
control the AutoPurification System. 

MassLynx software provides the fundamental data platform for acquiring and 
managing mass spectrometry information. It includes many features to 
analyze and process acquired data. 

FractionLynx software uses defined sample list parameters to control system 
modules for automatic peak tracking, fraction-collection triggering, and 
processing.

See also: MassLynx online Help and the FractionLynx online Help.

AutoPurify method

The AutoPurify™ method automates the stages of the purification process. 
Parameters set in the AutoPurify method are saved as FractionLynx 
processing files (*.flp).  A FractionLynx processing file is required to process 
data or invoke automatic analytical-to-preparative processing and/or 
preparative-to-analytical processing. 

To use the AutoPurify method, first define the method, which is stored in the 
MassLynx directory as a file with an *.flp extension. Then specify the 
AutoPurify method in the Parameter File column of the sample list, and select 
AutoPurify from the list of executable functions in the Process column of the 
sample list. 

At the end of each processing stage, and if required by the FractionLynx 
method, AutoPurify generates a batch file for the next processing stage and a 
FractionLynx report file (*.fpt). The report summarizes the results of the 
processing stage. You can therefore review the software’s choices before 
allowing samples to advance to the next stage of the purification process, if the 
system is running in manual mode. In automatic mode, the software runs all 
processing stages without user intervention. To automate the stages 
(analytical to preparative and/or preparative to analytical), the AutoLynx™ 
connectivity tool must be running. 

See also: “Creating methods in FractionLynx” in the FractionLynx online 
Help.
1-10 System Overview
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Fraction simulation

After you run a preparative sample and collect chromatographic data, you can 
adjust collection parameters in the FractionLynx method using the fraction 
simulation function. When you change collection parameters in the 
chromatogram window, this feature shows how the collection would be 
implemented in subsequent preparative runs. Simulated fractions appear on 
the chromatogram, labeled “Simulated,” and depict the peak collection 
graphically. Once collection parameters are optimized, you can export the 
changes to the FractionLynx method. 

Recommendation: Use fraction simulation to optimize a FractionLynx 
method for preparative peaks and multiple injections.

AutoMIT

FractionLynx software uses several criteria to determine when to collect 
fractions. One criterion is the minimum intensity threshold (MIT). The 
software measures the intensity level of the background response and triggers 
collection when the level exceeds a minimum background threshold. 

You can determine the MIT manually or by using AutoMIT. Nevertheless, 
AutoMIT is the more efficient method. Background levels can vary by 
wavelength or mass within a sample, and manually reviewing each trigger to 
determine optimum levels consumes time and limits the effectiveness of 
high-throughput sample processing. AutoMIT assigns a specific MIT value for 
each sample based on the background response of a blank injection. 

Total flow and gradient calculator

The software can calculate the gradient table of a 2545 binary gradient 
module (BGM) and program the instrument to coordinate the flows of up to 
three additional 515 HPLC pumps. In this way, each 515 pump can contribute 
to the system flow when necessary. 

See also: “At-Column Dilution Application Notes” (part number 
71500078010), which is available at www.waters.com.

Early run termination

You can set the software to end the run after the target compound is collected 
so that the system switches to the next sample. Early run termination saves 
time, collection vials, solvent consumption, and waste generation. 
System components 1-11
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To terminate a run early, you must enter a value in the “Number of fractions 
to collect” field in the Volume tab of the FractionLynx method.

Examples: If you enter 1 in the “Number of fractions to collect” field, one 
fraction is collected before the run is terminated. If you enter 3 in this field, 
three fractions are collected before the run is terminated. 

If the specified number of fractions is not reached, the run ends as specified in 
the acquisition methods. When using off-line column regeneration, you must 
specify a minimum run time setting in the Volume tab of the FractionLynx 
method. If you are using a single column, you must use a post-run method, 
which allows the column to be cleaned with high organic solvent and is run 
after every injection.

The post-run method requires an additional column in the sample list. A 
pre-run method can be used to reequilibrate the column at initial conditions 
before each injection. The pre-run method also requires an additional column 
in the sample list. 

Recommendation: Off-line column regeneration might terminate the run 
before the off-line column is ready. To avoid this situation, enter a minimum 
run time in the FractionLynx method. 

AutoDelay time determination

The AutoDelay time feature automatically calculates the delay time between 
detection and collection. 

See also: Performing a delay timing test. 

Open Access software 

Open Access (OA) Login lets you run samples even if your experience and 
training in LC/MS is limited. The interface presents a series of prompts that 
guide you through the sample submission process. OA Login requires only 
that you enter your name, provide the sample ID, select a predefined 
FractionLynx processing method (*.flp), and then place the samples in the 
designated position in the autosampler. This simplified process is called 
“walk-up.”

System administrators must configure OA Login and create the methods for 
the users.
1-12 System Overview
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The Open Access software has solvent and waste monitoring features. In Open 
Access mode, you can edit the 2545 binary gradient module’s gradient but not 
its flow rate. 

Solvent and waste monitoring

You can monitor the solvent usage by the 2545 binary gradient module and 
auxiliary pumps. You can input the reservoir volume for each pump, and the 
software measures solvent usage based on the gradient conditions employed. 

As the solvent reservoir is depleted, the volume in the waste drum increases. 
The waste volume calculation is based on the quantity of solvent pumped. 

You can set two limits for each reservoir and waste container, warning and 
acute, each with different responses. For solvents, specify the lower limits and 
fill the reservoirs when empty. For waste, specify the upper limits and empty 
the container when full. You can configure the system to shut down when 
either warning level is reached. 

The software informs you when a limit is reached or is below warning levels 
with an on-screen computer message and/or via e-mail. 

Exceptions: 

• The software does not monitor the usage of 2767 Sample Manager wash 
solvent, either as consumed from solvent reservoirs or as added to a 
waste container. 

• The volumes of collected fractions are not subtracted from the waste 
calculation. 

System shutdown

You can specify that the system automatically shut down at the end of the run 
or in the event of an adverse condition. The system response is tiered, 
allowing you to specify system shutdown 

• immediately. 

• after the current injection is completed. 

• after the batch is finished. 

See also: “Stopping or pausing a run” in the FractionLynx online Help.
System components 1-13
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Options

The AutoPurification system has several configurable options.

Leak detection
System-level leak sensing offers six points of detection routed to a central 
module. The optional leak sensor module consists of liquid sensors, tubing, 
and a control module in the system fluidics organizer. 

The Waters field service engineer installs the sensors and sensor brackets in 
drip trays where leaks are most likely to occur. If a leak occurs, the drip tray 
of each component collects solvent and directs it through tubing to a sensor. 
The liquid sensor sends a signal to the control module, which signals the 
pump to stop the solvent flow.

Additional fraction collectors
Additional fraction collectors can be added for increased capacity or secondary 
collection. The collector/selector valve is recommended when using multiple 
fraction collectors.

Waste collection
The waste collection option enables you to add multiple collectors to the 
system for waste collection. All solvent that is not collected by the primary 
collector is collected in a single waste vessel for each injection.

Columns
The system fluidics organizer can accommodate three analytical and two 
preparative columns. 

Analytical columns

You can use analytical columns that range in length from 50 mm to 150 mm.

Examples: Atlantis®, SunFire™, and XBridge™.
1-14 System Overview



book.book  Page 15  Wednesday, December 13, 2006  2:53 PM
Preparative columns

You can use preparative columns that range up to 150 mm in length and 
30 mm in diameter. 

Examples: XTerra® Prep, Atlantis, SunFire, and XBridge.

Guard columns

You can add a guard column before each column to protect it from 
precipitates, impurities, and contaminants in the samples and from 
potentially damaging solvents. 
Options 1-15
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2 Preparing the System

Contents:

Topic Page

Preparing for operation 2-2

Running samples 2-3

Running samples using OA Login 2-8

Shutting down the system 2-10

Testing system performance 2-13

Using the waste detector 2-42

Determining the system dwell volume 2-47
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Preparing for operation

Perform the following tasks regularly to keep the system working optimally. 

Routine tasks to prepare for operation

• Restock solvents.

• Empty waste containers.

• Check the drip trays for leaks and correct placement.

• Open MassLynx and FractionLynx.

• In FractionLynx, check the system status and ensure that there is 
communication with all components.

• Restock tubes in the fraction collector, reset the beds in FractionLynx, 
and check the status of the collection system modules. 

Tip: In the FractionLynx Collection Control window, click System 
Overview > Control > Reset beds.

• Prime pumps.

• Remove sample plates from the sample manager.

• Check the syringe and plunger. Wash and prime the sample manager.

• Check columns and guard columns, and check the backpressure to 
ensure that it is stable. Replace columns if needed.

• Check the flow rate and ensure that it is suitable. 

If you changed the tubing or flow rate, you must pressure balance the 
system. Flow rate changes and plumbing changes after the splitter 
affect pressure and timing.

See also: Balancing pressures and flows on an MS-directed system on 
page 2-14.

• Ensure the makeup pump is operating and that the pressure is stable.

• Run a QC (quality control) sample to verify system performance (for 
example, run the dye test).

Warning: To avoid electrical shock, ensure the flow splitters and columns are 
properly grounded.
2-2 Preparing the System
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Running samples

A sample list defines the samples available for separating by chromatography 
and analyzing by a mass spectrometer, UV detector, or another detector. 
When you create and/or run sample lists in MassLynx, you must customize 
them for fraction collection. The sample list contains information about the 
instrument configuration (inlet method), processing method, fraction trigger, 
and wavelength of interest. It also identifies the monoisotopic mass of interest 
and the FractionLynx method.

Rule: Power-on all instruments before opening MassLynx.

Before you start a run, you must perform the following tasks:

1. Check the status of the instruments. In the sample list toolbar, click 
Status. All the indicator lights must be green.

2. Verify that additional application managers are running:

• If you are collecting fractions, ensure that FractionLynx collection 
control is activated. When you activate FractionLynx collection 
control, the software downloads the beds and establishes 
communications between MassLynx and the fraction collectors.

• If you are using AutoPurify and making injections from the sample 
list, verify that AutoLynx software is running. 

• If users are submitting samples via OA Login, ensure that OA 
Manager and OA Login are running. However, if users are using 
AutoPurify with OA Login, ensure that AutoLynx is closed. 

See also: “Running samples from a sample list” in the FractionLynx 
online Help.

To create a sample list: 

1. In MassLynx, the last project you worked on automatically opens. If that 
project is not the one you want, find and open the correct project by 
clicking File > Open Project.

2. Load samples in the sample manager. 

See also: Waters 2767 Sample Manager Installation and Maintenance 
Guide.

3. Define the sample list in MassLynx. From the MassLynx Main window, 
click Samples > Format > Load. 
Running samples 2-3
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Load sample list format: 

4. In the Load Sample List Format dialog box, click FractionLynx > OK. 

5. To customize the sample list, click Samples > Format > Customize.
2-4 Preparing the System
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Customize field display dialog box:

6. In the Customize Field Display dialog box, select the check box for the 
required column to add or remove the column.

Tip: Before you remove a column, ensure its cells are empty. MassLynx 
software executes the commands in the column even if they are hidden 
from view.

Using the arrow keys, arrange the order of the columns, and then click 
OK.

See also: “Creating sample lists to collect fractions” in FractionLynx 
Help.

7. Customize the format to meet your needs, and then save it with a new 
name. 

Caution: Using the same file name in more than one sample list 
can cause an error. Append the file name with a suffix to make it 
unique in multiple sample lists.
Examples: TestDyes02, TestDyes03, TestDyes04.

!
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8. Enter sample information into the sample list. 

9. Equilibrate the system: run it at initial conditions for three to five 
column volumes. Ensure that the pump pressure meets your 
expectations and that no excessive fluctuations occur.

To run samples from a sample list: 

1. From the MassLynx main window, click  (Start Run) on the toolbar. 

2. In the Start Sample List Run dialog box, select one or more of the 
following options:

• To acquire data for all the highlighted rows in the sample list, select 
the Acquire Sample Data check box. Do not select this option if you 
are post-processing previously acquired data.

• To process previously acquired data using a previously created 
AutoPurify method (*.flp file), clear the Acquire Sample Data check 
box, and select the Auto Process Samples check box. The AutoPurify 
method you specified in the sample list processes the data and 
creates a browser report with the results. 

See also: “Creating and modifying an AutoPurify method” in 
FractionLynx online Help.

• To acquire and process data automatically, select the Acquire 
Sample Data and Auto Process Samples check boxes.

Tip: Do not select the Pre-Run, Auto Quantify Samples, and 
Post-Run check boxes. They do not apply to FractionLynx.

3. In the From and To sample fields, specify the samples you want to run 
by performing one of these tasks:

• Highlight the samples in the sample list that you want to run.

• In the From Sample and To sample fields, specify a range of 
samples.

• You need not do anything further to run all samples in the sample 
list.

Default: Samples are run in sequential order.

4. To assign priority to a sample list so that it runs ahead of non-priority 
lists in the queue, select the Priority check box.

5. If you want to run a sample list overnight, select the Night Time Process 
check box.
2-6 Preparing the System



book.book  Page 7  Wednesday, December 13, 2006  2:53 PM
6. To add the sample list to the MassLynx queue, click OK.

See also: “Running samples from a sample list” in FractionLynx Help.

Result: The sample queue appears at the side of the window. Within it, 
you can delete, prioritize, and pause sample lists.

7. Process and review results in the FractionLynx browser. 

See also: “Viewing fractions on a chromatogram” and “View results in 
the FractionLynx browser” in FractionLynx online Help. 

Tips: 

• To monitor the status of the current fraction collection, including 
peak detection and collection system versus waste system volume, 
click FractionLynx > Collection Control > System > FractionLynx - 
Collection Control window. 

• To monitor the status of a run in MassLynx, click Instrument > 
Inlet Method. The Inlet Method window appears with the LC and 
detector status. Click the 2545 Additional Status tab in the Inlet 
Method window to monitor the status of the 2545 binary gradient 
module and the 515 pumps. Check the solvent levels tab to view 
solvent and waste status. 

• To monitor the MS status, LC status, and System status, click 
Status at the top of the MassLynx sample list screen. 

To pause a run:

1. Click  (Pause) on the MassLynx toolbar. When you pause a run, an 
initiated task finishes, but the next task does not begin. If the sample 
manager is in the middle of injections, it finishes loading the injector 
loops, and then pauses the run. 

For example, if the sample manager is rinsing injector ports, the run is 
paused after the rinse cycle.

2. To resume the run, click  (Start Run).

To stop a run:

1. Click  (Stop) on the Inlet Method toolbar or select LC > Stop Method, 
and then click  (Stop) on the MassLynx toolbar. 

2. To verify that the run stopped, check the Status Overview page in the 
Inlet Method window.
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Running samples using OA Login

OA Login simplifies the process of running samples on the autosampler. An 
OA Login administrator defines the sample information that you must provide 
to run samples. A wizard guides you through the sample submission process. 
OA Login requires only that you enter your name, provide the sample ID, 
select a predefined method, and then place the samples in the designated 
position in an autosampler, a process called walk-up. You can print results in 
a report, or e-mail them for review.

To run samples using OA Login:

1. From the FractionLynx main window, click OA Manager.

2. In the OA Login Manager window, click Administration > Set Bed 
Layout.

3. In the Select Bed Layout dialog box, select the “Use current MassLynx 
autosampler bed layout” check box, and then click OK.

4. Click Start > Programs > OALogin > OALogin.

Tip: If Secure mode is enabled, the term “Security” appears in the menu 
bar. To disable Secure mode, click Security > Swap Mode, and then enter 
your name and password.

5. In OA Login window, click Admin > Login Options.

6. In the OA Login Options dialog box, click AutoPurify.

Tip: If you selected the “Allow single sample file login” check box and you 
are submitting barcoded plates, select the check box “User Batch ID as 
Sample List File Name.” Doing so enables OA Login to read a 
tab-delimited file with the same name as the batch ID from the defined 
path. If such a file does not exist, or it includes more parameters than 
these defined in the walk-up method selected, an error message appears.
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OALogin Options dialog box with AutoPurify selected:

7. Log in samples using either the wizard or the single-page log-in.
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Shutting down the system

You can create a shutdown method in MassLynx software to specify when and 
how the software performs the shutdown procedure. You can specify shutdown 
procedures when one or more of these conditions occurs:

• At the end of the run or when the sample list (queue) is paused.

• In the event of an adverse (error) condition. 

• In the event of a warning or acute level message relating to solvent or 
waste monitoring. 

As part of a shutdown method, you can specify how the software performs 
shutdown tasks as follows:

• Defining shutdown tasks such as turning the LC pump off, putting the 
mass spectrometer in standby mode, and turning the UV lamp off. 

• Specifying a delay time before the software initiates shutdown 
procedures. Delay time is the time period that the system waits before 
the software begins performing shutdown tasks. 

• Optimizing shutdown procedures by directing the software to omit 
unnecessary tasks. When you select the Optimize check box, the 
software compares the current status of the instrument against each 
configured task. If the instrument is already in this state (for example, 
LC pump is turned off), the task is not performed. 

• E-mailing the system administrator. When you select the “E-mail 
recipient” check box and enter an e-mail address, the software notifies 
the recipient of the shutdown. 

See also: “Shutdown tab” in the MassLynx help. 

To create a shutdown method in MassLynx: 

1. Click Instrument > Edit Shutdown or Startup. 

2. In the Shutdown dialog box, select shutdown option check boxes in the 
Shutdown tab, and select shutdown tasks in the Auto Control Tasks tab. 

3. Click File > Save As to save the shutdown method. 

After you define these tasks, you must specify the shutdown method you 
created in the Shutdown dialog box.
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Specifying shutdown conditions:

See also: Startup and shutdown topics in MassLynx Help.

Specifying emergency shutdown conditions

In case of an emergency, you can specify that the software run the shutdown 
method immediately or after a specified delay time. You must specify the error 
conditions that constitute an emergency, such as an error with the mass 
spectrometer, an external device, or with an inlet device, such as an LC or GC. 
In addition, you can specify that the software run the shutdown method when 
the solvent monitor detects one or more vessels at the warning or acute level. 
You can also specify that a person receive e-mail notification of the shutdown.

To specify emergency shutdown conditions:

1. In the Shutdown dialog box, click the Configure error shutdown button.

2. In the Shutdown on Error Configuration dialog box, select the following 
parameters:

• The error conditions (mass spectrometer error, solvent monitor at 
the acute level).

• A previously created shutdown method.

• When to run the shutdown method: immediately or after a specified 
delay time. 
Shutting down the system 2-11



book.book  Page 12  Wednesday, December 13, 2006  2:53 PM
Tip: The solvent monitoring capability has additional shutdown 
responses: Shutdown after the current sample or Shutdown after the 
current batch. 

3. Click OK > Save As to save the shutdown method.

Recommendation: If you use OpenAccess to run samples, select the Optimize 
check box and specify a shutdown time delay.

Specifying shutdown error conditions:

At the bottom of the MassLynx window, the status bar indicates the current 
shutdown status of the instrument, such as Shutdown Disabled, Shutdown 
Enabled, or Only Error Shutdown Enabled.
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Testing system performance

After installing FractionLynx, you must test the system to confirm that the 
instruments are functioning correctly, and that the system produces the 
expected chromatographic results. 

Testing involves using the Sample Dye Kit (part number 716000765) to inject 
dyes and subsequently collect them. A passing result for this system-level test 
means that the system instruments function properly. If the test results differ 
from those in the examples provided, ensure that collection parameters are set 
appropriately.

See also: Chapter 3, Maintenance and Troubleshooting, and “Testing system 
performance” in FractionLynx online Help.

The conditions defined in each of the following tests are designed to help you 
rapidly determine whether all the components function as a system. Actual 
system performance (column load per run) depends greatly on conditions such 
as the HPLC solvents or modifiers, and the dimension of the columns.

For the MS-directed system test and UV-directed system test, many 
FractionLynx method parameters are identical, including the gradient and 
UV detector parameters. The chromatogram examples represent results that 
you should expect, although they can differ somewhat from system to system. 
As part of the system test, you also perform these procedures:

• Balancing pressures and flows on an MS-directed system on page 2-14.

• Performing a delay timing test on page 2-18.

• Performing a chromatography test on page 2-34.

Before running system tests

Confirm that these system components are set up correctly to avoid possible 
damage to the injectors and to prevent solvent leaks: 

• Before running the pumps, ensure that the bed layout and reference 
position values are correct in the sample manager and fraction collector. 

• Ensure that the syringe size, injection loops, and holding loops are 
correctly set, matching the actual installed instruments on the system 
and as defined in the Inlet method.

See also: The Waters 2767 Sample Manager, Injector and Collector Main- 
tenance Guide and the Waters Fraction Collector II or III Operator’s Guide.
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Balancing pressures and flows on an MS-directed system
Before performing the timing test, balance system pressures.

Guideline: To function correctly, the splitter requires approximately 100 psi 
or more backpressure on the preparative side of the fraction collector system. 
Any additional restrictions downstream can affect the split ratio and require 
rebalancing the system pressures. Changing the flow rate or the plumbing 
requires rebalancing the pressures and flow to the mass spectrometer.

Recommendation: Use 50% organic mobile phase, as 50% is the midway point 
for most gradients. The pressure must be constant to obtain accurate 
readings.  

To measure system pressure:

1. In the Inlet Editor, specify flow rates for both the preparative and 
makeup pumps. 

• For the preparative pump, create a method to run 50:50 
acetonitrile/water.

• For the makeup pump, set the flow rate at 1 mL/min. with 100% 
methanol.

2. Run the system at the desired flow rate, and wait for the pressure to 
stabilize. 

3. Record the system pressures from the front panels of the pumps on the 
System Pressure Form.

4. To measure the pressure on the makeup side of the pump, disconnect 
the fitting on the splitter, wait for the pressure to stabilize, and record 
the makeup pump pressure on the System Pressures Form.

5. Reconnect the 1/1000 or 1/10,000 fitting and wait for the pressure to 
stabilize.

6. To measure pressure on the preparative side of the splitter, disconnect 
the collection fitting on the preparative side of the splitter, wait for the 
pressure to stabilize, and record the pressure on the System Pressures 
Form. 

Warning: To prevent injury, wear solvent resistant gloves and eye 
protection when performing this test. 
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7. Reconnect the fitting and wait for the pressure to stabilize. Due to the 
high flow rate, you might need to stop the pump to reconnect the fitting. 

8. Calculate the difference in pressure between the preparative and 
makeup sides, and enter the values on the form.

Rule: The pressure must be greater by approximately 100 psi on the 
preparative side than on the makeup flow side of the splitter. 

Tip: You can adjust the pressure difference by adding or removing any 
restriction from the flow path. To increase the backpressure, you can 
add a short piece of small-diameter tubing, usually 0.010 inch on the 
prep side of the flow path. 

9. After adding or removing tubing, repeat the system pressure test. 
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System pressure form:

Recommendation: Keep a copy of this page as a template for future pressure tests.

System Pressure Readings

Prep side before disconnection: __________psi

Delta: __________psi

Prep side after disconnection: __________psi

Difference 
between prep side 
delta and make-up 
side delta:

________psi

Make-up flow side before disconnection:
__________psi

Delta: __________psi

Make-up flow side after disconnection:
__________psi

Pressure test performed by:____________________________________________________________

Title/Dept.: ________________________________________ Date:____________________________

Comments and notes:________________________________________________________________ 
____________________________________________________________________________________
______________________________________________________________________________

Mobile 
phases:___________________________________________________________________________ 
____________________________________________________________________________________
______________________________________________________________________________

Flows:________________________________________________________________________
_____________________________________________________________________________
___________________________________________________________________
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To measure the flow to the mass spectrometer:

1. Set the makeup pump to deliver methanol at 1 mL/min.

2. Disconnect the fitting going to the tee or the splitter before the probe. 

3. Collect the solvent for one minute into an Eppendorf tube. Measure the 
solvent collected using a syringe. It should be the same as the 
programmed flow (1 mL).

4. The mass spectrometer should be receiving 20% of the 1 mL/min flow 
from the makeup pump. You can confirm this percentage as follows:

• Place an Eppendorf tube at the outlet of the waste line from the UV 
detector. Wait for a steady waste stream to exit the waste line from 
the UV detector.

• Measure the flow output for 1 minute.

• Use a syringe to measure the solvent collected, which should not be 
less than 800 µL.

5. If the volume of collected solvent is less than 800 µL, then too much 
solvent is going to the mass spectrometer, and you need to adjust the 
split. You can adjust the split by changing the tubing lengths coming 
from the tee.

Example:  When 1000 µL/min is flowing to the split, which is upstream 
of the mass spectrometer and UV detector, and 800 µL/min is flowing 
out of the detector, then 200 µL of solvent must be flowing to the mass 
spectrometer. 

Rule: The optimum value for an electrospray mass spectrometer source 
is 200 µL/min.

Tip: When creating a split using a tee and tubing of different diameters, 
you can adjust it by adding or removing tubing. Replacing a piece of 
tubing with a longer piece of the same diameter tubing creates more 
pressure on that part of the split, reducing the volume of solvent passing 
through. If insufficient solvent is flowing to the mass spectrometer, add 
more tubing to the UV detector side of the split, or remove some tubing 
from the mass spectrometer side.
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Performing a delay timing test
The FractionLynx AutoDelay feature automatically determines the delay time 
between the detectors that trigger fraction collection and the fraction collector. 
You can determine the delay time manually or automatically. To calculate the 
delay time manually, follow the procedure outlined on page 2-32. In the 
automatic method, the delay time is determined using a series of injections 
from a caffeine standard. You can enter the delay time into the FractionLynx 
method manually, or the software can export the delay time into the 
FractionLynx method.

Determining the delay time automatically

You can run the AutoDelay wizard in one of two modes: simple or advanced. 
The detectors configured in the AutoPurification system influence which mode 
you run.

Simple mode automatically considers the first analog channel to be the waste 
detector data channel. If there are no analog traces, then the software uses 
the last detector configured in the inlet method as the waste detector channel. 
In simple mode, the injections required for delay time determination run 
consecutively without user input.

For example, if the AutoPurification System has a mass spectrometer or PDA 
detector as the fraction trigger detectors and either a 2487 detector under 
IEEE control or an analog device as the waste channel detector, use simple 
mode. 

In Advanced mode, the user defines which detector is the waste detector and 
which detector trace is the trigger. 

Requirement: If one of the detectors is configured as a Waters ELSD, you 
must use advanced mode. The ELSD is considered an IEEE-controlled device 
with analog data, which complicates the automatic identification of the waste 
detector channel.

After determining the delay time, the software reports its findings, and you 
can copy or export the results to the FractionLynx method. FractionLynx 
software can create an AutoDelay report that you can print and archive. The 
AutoDelay report contains the chromatography performed as a part of this 
test. 

Tip: Good chromatography and good integration of the peaks are essential for 
success. It is important to maintain good peak shape and have only a single 
peak.
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Requirements:

• Caffeine Test Kit (included in the Waters Sample kit), part number 
700003233. 

• A detector in the waste stream plumbed to the fraction collector using 
appropriately-sized tubing. Ensure that the tubing does not increase 
peak width and does not add more than 100 psi backpressure.

• Mobile phases:

– A % Water/TFA or Water/formic acid, 0.1% (v:v).

– B % Acetonitrile/TFA or acetonitrile/formic acid, 0.1% (v:v).

• Waters 19-mm × 50-mm column. 

Exception: If you are using a column of a different size and type, you 
must adjust the flow and injection volumes accordingly. You must 
pressure balance the purification system at the purification flow rate.

Prerequisites:

You must perform the following tasks before you can automatically determine 
the delay time:

• Perform the system test and balance system pressures, and if required, 
test the flow to the MS probe. 

• Determine the length and internal diameter of the tubing that connects 
the fraction collector to the waste detector. 

• The standard tubing that is pre-installed in the instrument is 
3048 mm (120 inches) in length and 1.575 mm (0.062 inches) in 
diameter. If the tubing has been replaced or cut since installation, 
measure the length to within the nearest 15 cm (6 in).

• Determine the ID of the tube installed. Different diameter lengths of 
tubing ship with the instrument and depend on the operational flow 
rate of the AutoPurification system:

– 1.016 mm (0.40 in)

– 0.762 mm (0.30 in)

– 0.508 mm (0.02 in)

Tip: Once you run the AutoDelay wizard and enter the tubing 
dimensions, the software retains these dimensions. The next time 
you run the wizard, you need not enter the tubing dimensions, as 
they were automatically retained from the previous run. The 
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AutoDelay report contains the tubing dimensions, which you can 
reference the next time you perform the timing test.

• In MassLynx software, create inlet and MS methods.

• Configure and plumb the waste detector in the waste stream after the 
fraction collector. 

• Ensure that the fraction collector is loaded with sufficient fraction tubes. 
The fraction must fit into a single tube.

Creating methods for the AutoDelay test

Before you run the AutoDelay wizard, you must create inlet and MS methods 
in MassLynx software. Once created, you can reference these methods any 
time you run the AutoDelay wizard. The total run time for the inlet method is 
3 minutes.

Perform the AutoDelay test at the flow rate that you use for purification. You 
might need to scale the inlet method to account for your column diameter, 
length, and flow rate. 

See also: Total flow and gradient calculator on page 1-11.

To create an inlet method for the AutoDelay test:

1. Enter the flow rate used to check system pressures.

2. Enter the inlet method in the table below for the 2545 binary gradient 
module.

3. Enter a total run time of 3.00 minutes.

Waters 2545 Binary Gradient Module parameters for the inlet method

Time 
(min)

Flow
(mL/min) %A %B Curve

1 Initial 30.00 95.0 5.0 Initial

2 0.25 30.00 95.0 5.0 6

3 1.50 30.00 30.00 70.0 6

4 1.60 30.00 95.0 5.0 6

5 3.00 30.00 95.0 5.0 6
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4. In the Inlet Editor, configure the primary and waste detectors as follows:

• If the detector is IEEE 2487, enter a wavelength of 254 nm.

• If the detector is a PDA, enter a scan range of 240 to 290 nm.

• For the waste detector, enter a collection rate of at least 5 Hz. 

• Enter a run time of 3 minutes.

5. Save the method. 

Example: 3min_caff_gradient

To create an MS method:

1. Set the scan range from 150 to 250 Da.

2. Use the default settings for scan speed and interscan delay.

3. Enter a total run time of 3 minutes. 

4. Save the method. 

Example: 3min_caff
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Using AutoDelay in simple mode

After you create an inlet and MS method, you can run the AutoDelay wizard.

To determine the delay time automatically in simple mode:

1. In FractionLynx, click Collection Control > AutoDelay Wizard.

2. In the AutoDelay wizard’s Introduction page, do not select the Advanced 
Mode check box, and click Next. 

AutoDelay Wizard Introduction page:

Do not select this
check box.
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3. In the AutoDelay wizard’s Set-up page, enter the tubing length and ID, 
and then click Next. 

• In the Tubing length field, enter the length of the tubing that 
connects the waste detector to the fraction collector. 

• In the Tubing ID field, enter the tubing’s internal diameter.

AutoDelay Wizard Set-up page: 

Example.
Your tubing might vary. 
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4. In the AutoDelay wizard’s Make Injections page, enter the following 
parameters, and then click Run Injections:

• In the Inlet and MS Method fields, select the Inlet and MS methods 
that you created earlier.

• In the Bottle Location field, enter the caffeine standard vial 
location.

Tip: Use the same naming convention as in the sample list.

• In the Injection Volume field, enter the injection volume. 

Recommendation: 100 µL of the 1.00 mg/mL test solution. 

• In the Mass field, enter the M + H value (195 Da) as the mass of the 
caffeine sample to be monitored. 

AutoDelay Wizard Make Injections page:

Result: Two injections are automatically performed, the first one 
without fraction collection, the second with fraction collection. 

Exception: If you installed SCN 562, a third injection is performed. This 
injection confirms that the software determined the correct delay time.

Once the injections finish successfully, the Results page appears 
(page 2-30).
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Using AutoDelay in advanced mode

In advanced mode, the two injections required for delay time determination do 
not run automatically. After the first injection, you must specify which 
detector triggers fraction collection and which detector monitors the waste 
stream. You must also start the second injection. 

Rule: For those systems that contain a Waters evaporative light-scattering 
detector, use AutoDelay in advanced mode.

To regenerate a delay time report, you can reprocess data files collected 
earlier.

To determine the delay time automatically in advanced mode:

1. In FractionLynx software, click Collection Control > AutoDelay Wizard.

2. In the AutoDelay wizard’s Introduction page, select the Enable 
Advanced Mode check box, and then click Next.

AutoDelay Wizard Introduction page:

3. In the AutoDelay wizard’s Set-up page, enter the tubing length and ID, 
and then click Next.

• In the Tubing length field, enter the length of the tubing that 
connects the waste detector to the fraction collector. 

• In the Tubing ID field, enter the tubing’s internal diameter.

Select this 
check box.
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4. In the AutoDelay wizard’s First Injection page, take one of these actions:

• If this is the first time you are running this wizard, select the “I 
want to run a sample to get the data” check box, and enter these 
parameters:

– In the Inlet and MS Method fields, select the Inlet and MS 
methods that you created earlier.

– In the Bottle Location field, enter the caffeine standard vial 
location.

– In the Injection Volume field, enter the injection volume, and 
then click Run Sample. 

Recommendation: 100 µL of the 1.00 mg/mL test solution. 

Result: The software performs the first injection.

• If you do not want to make an injection but want to regenerate data, 
do not select the “I want to run a sample to get the data” check box. 
Select a data file that was collected previously in the Raw File field, 
and enter the flow rate.

AutoDelay Wizard First Injection page:

Select this check box.
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5. In the AutoDelay wizard’s Select Chromatograms page, enter the 
following parameters, and then click Next:

• For the detector that triggers fraction collection, select the scan 
function and mass or wavelength trigger. 

Example: For the mass spectrometer, the mass that triggers 
collection is 195 Da for caffeine. In a UV-directed system, set the 
scan function to 254 nm.

• For the waste detector, select the scan function and either TIC or 
254 nm. 

Example: In this example, the IEEE 2487 is the waste detector and 
it is configured as Function 3: Diode Array.

AutoDelay Wizard Select Chromatograms page:
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6. If you selected “I want to run a sample to get the data” in the First 
Injections page, enter the following parameters in the Second Injections 
page, and then click Run Sample:

• In the Inlet and MS Method fields, select the Inlet and MS methods 
that you created earlier.

– In the Bottle Location field, enter the caffeine standard vial 
location.

– In the Injection Volume field, enter the injection volume. 

Recommendation: 100 µL of the 1.00 mg/mL test solution. 

Result: The system performs the second injection.

• If you do not want to make an injection and want to regenerate data, 
do not select the “I want to run a sample to get the data” check box. 
Select a data file that was collected previously in the Raw File field, 
and enter the flow rate.

AutoDelay Wizard Second Injection page:

Result: FractionLynx performs the second injection or regenerates the 
data, and then the Results page appears.
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7. If you installed SCN (Software Change Note) 562, the Confirmation 
Injection page appears. If you installed SCN 568, go to step 8. The 
Confirmation Injection page confirms that the software correctly 
determined the delay time in the previous two injections. 

Tip: To determine the SCN that is installed on your system, click Help > 
About MassLynx from the MassLynx main window.

In the Confirmation Injection page, do one of the following: 

• In the Inlet and MS Method fields, select the Inlet and MS methods 
that you created earlier.

– In the Bottle Location field, enter the caffeine standard vial 
location.

– In the Injection Volume field, enter the injection volume. 

Recommendation: 100 µL of the 1.00 mg/mL test solution. 

Result: The system performs the confirmation injection.

• If you do not want to make an injection and want to regenerate data, 
do not select the “I want to run a sample to get the data” check box. 
Select a data file that was collected previously in the Raw File field, 
and enter the flow rate.

AutoDelay Confirmation Injection page:
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8. In the AutoDelay Wizard’s Results page, perform one of the following 
tasks:

• To view the AutoDelay report, click View Report. 

Tip: The AutoDelay report is an .html file that is automatically 
saved. You can click File > Save As to save it with a new name. 

• To update a FractionLynx method with the delay time parameters, 
click Update Method.

Recommendation: For UV-directed systems, record the delay time, 
and then manually enter it into the FractionLynx method.

• If there are warnings in the report, the Results page instructs you to 
check the report for details.

• To repeat the test, click Finish, and start the wizard again.

• To exit, click Finish.

AutoDelay Wizard Results page:

In this example, the delay time between the MS and the waste detector 
is 10.96 seconds, and the delay time between the MS and the PDA 
detector is 1.67 seconds. 
2-30 Preparing the System



book.book  Page 31  Wednesday, December 13, 2006  2:53 PM
AutoDelay Report:

The AutoDelay report displays the chromatograms from the injections. In this 
example, the report depicts an overlay of the two chromatograms, and the 
boxes show the integration points, beginning, and end for each peak. 

If the integration start of the waste peak occurs before the integration start of 
the trigger peak, a timing error is generated. If this situation occurs, it could 
be caused by a noisy baseline. To correct this problem, inject a larger amount 
of sample. 

Requirement: Use the single compound standard. A compound with multiple 
peaks interferes with the software’s ability to determine which peak should be 
used to determine the delay time.

To save the AutoDelay report:

1. Click File > Save As.

2. In the File Save As dialog box, enter the name of the AutoDelay report, 
and then select the file location to save the report.
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Result: The AutoDelay report is saved in the Data folder of the current 
project. The next time you run the AutoDelay wizard, these files will be 
overridden unless you save them to a new location.

Performing the delay timing test manually
You can determine the delay time manually by injecting a dye sample from 
the sample dye kit. The dye is a mixture of three compounds. The following 
test is conducted using a Waters 19-mm × 50-mm XTerra column.

Rule: When using a different size and type of column than the one prescribed 
here, you must adjust flow and injection volumes accordingly. Pressure 
balancing and flow to the mass spectrometer must be performed at the 
purification flow rate. When using the column isocratically, the retention time 
is about 90 to 120 seconds, based on the column size and flow rate. 

Required materials:

• Stopwatch

• Mobile phases:

– A Water/TFA, 0.1% (v:v) 

– B Acetonitrile/TFA, 0.1% (v:v)

• Sample dye kit, part number 716000765 (in System Startup Kit)

To set up the delay timing test:

1. In the FractionLynx method, set the split collector delay to 30 seconds.

2. In MassLynx, create an inlet method with the following settings: 

• Run at the required flow rate for 3 minutes with 10% A and 90% B.

Test sample dye compounds

Item Thionin acetate Thioflavin T Crystal violet

m/z 227.1 282.1 371.2

UVmax 590 nm 418 nm 590 nm

Formula C12H9N3SC2H4O2 C17H19CIN2S C25H30CIN3

Sigma part number T3337 T3516 C3886
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• For UV-directed systems, set the UV detector to the following 
parameters, and ensure that the connections on the UV Fraction 
Manager correspond to the flow rate used for this test:

– Waters 2996 PDA Detector to scan from 200 to 600 nm.

– Waters 2487 UV Detector to monitor 418 nm and 590 nm.

3. For MS-directed systems, create an MS method for a 3-minute scan 
acquisition with electrospray + ve, and specify these parameters:

– Centroid = 150 to 550 amu scan for 0.5 seconds.

– Inter-scan delay = 0.1 seconds.

– Cone Voltage = 25 V.

To run the delay timing test:

1. In the MassLynx sample list, specify these values:

• Specify the Injection Volume as 100 µL.

• Enter these values depending upon the detectors configured in the 
system:

– For an MS-directed system, enter 227.1 in the Mass A column, 
282.1 in the Mass B column, and 371.2 in the Mass C column. In 
the Fraction Trigger 1 column, enter Mass A. In the Fraction 2 
column, enter Mass B. In the Fraction Trigger 3 column, enter 
Mass C.

– For a UV-directed system, enter 418 in the Wavelength A 
column and 590 in the Wavelength B Column. In the Fraction 
Trigger 1 column, enter Wavelength A for a PDA detector or 
UV1 for an UV detector, such as a Waters 2487. In the Fraction 
Trigger 2 column, enter Wavelength B for a PDA detector or 
UV2 for an UV detector.

Tip: UV1 and UV2 correspond to Channel A and Channel B wavelengths 
in the Inlet method. The setting in the Wavelength column is for 
reporting purposes only; it does not control the 2487 detector. The 
software uses the value set in the Fraction Trigger column, UV 1, UV 2, 
against the value set in the Inlet Editor.

2. When the injection occurs, monitor the waste line from the fraction 
collector valve. As soon as the dye appears in the waste line of the 
fraction collector valve, start the stopwatch.
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3. When you hear the fraction collector valve click to the dispense position, 
stop the stopwatch. The dye should have eluted before the collection 
valve opened.

4. Calculate the actual Splitter/Collector delay as follows:

The actual delay is equal to original Splitter/Collector delay specified in 
the FractionLynx method (e.g., 30 seconds) minus the time recorded on 
the stopwatch. 

Example: If the dye is seen in the waste line 15 seconds before the valve 
clicks to the collection position, the delay time is calculated as follows:

Actual splitter collector delay = 30 – 15 = 15 seconds.

5. In the Timing tab of the FractionLynx method, change the 
Splitter/Collector delay to the value just calculated, and rerun the 
experiment to ensure that the delay time is correct.

6. Repeat the procedure for all flow rates, such as 10, 15, 20, or 25 mL/min.

7. For the MS-based system, complete the procedure for APCI and ESI if 
you are using both probes. 

8. Perform a chromatography test of the entire system, as described below.

Performing a chromatography test
Requirements: Sample dye kit, which contains three compounds for testing 
the ability of the AutoPurification System to perform high-flow-rate targeting 
and fractionation of specified masses and wavelengths.

See also: The table titled Test sample dye compounds on page 2-32. 

The compounds elute in this order:

• Thionin acetate loses the acetate salt (C2H4O2) to give this [M+H] ion:

Thionin ([M+H] = 228.1), lambda max. = 590 nm

• Thioflavin T loses a Cl to give this [M+H] ion:

Thioflavin T ([M+H] = 283.1), lambda max. = 418 nm

• Crystal violet loses HCl to give this [M+H] ion:

([M+H] = 372.2), lambda max. = 590 nm

Tip: Report masses to one decimal place.
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Requirement: To perform the chromatography test, create an inlet method 
using the parameters provided in this procedure. Use the XTerra 19-mm × 
50-mm column to perform the tests. Scale the method appropriately for 
different flow rates and/or differently-sized columns. Use the flow rate that 
will be used for purification. 

To create an inlet method for the system test:

1. Set up the Inlet Editor to run a 10-minute method labeled “Dye.”

2. Set up the Waters 2545 binary gradient module to use these parameters:

• Mobile Phase A: Water with 0.1% TFA or 0.2% formic acid

• Mobile Phase B: Acetonitrile with 0.1% TFA or 0.2% formic acid

• Flow Rate: specify the same rate that you used in the delay timing 
test.

• Run Time: 10 minutes

• Gradient conditions as specified in the following table: 

3. In the Inlet Editor, set the wavelength range you want to acquire, based 
on your detector type:

• For a Waters 2996 PDA Detector, in the Inlet Editor, set the 
wavelength range to 210 nm to 650 nm. 

• For a Waters 2487 dual wavelength absorbance detector, in the 
Inlet Editor, set the single channel wavelength to 418. Set the dual 
channel wavelength to 590.

Gradient conditions for the system test

Time A% B% Curve Number

T = 0 minutes 95 5 6

T = 1 minutes 95 5 6

T = 7 minutes 30 70 6

T = 7.5 minutes 5 95 6

T = 8.5 minutes 5 95 6

T = 9 minutes 95 5 6

T = 10 minutes 95 5 6
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4. For an MS-directed system, create a mass spectrometer method with 
these parameters, and then set it to run for 10 minutes:

• Set up a Scan Function: 150 to 500 amu

• ES+ 

• Centroid Data 

• 0.5-second scan time with a 0.1-second Inter Scan Delay

• Cone Voltage = 35 V

5. In the MassLynx sample list, perform these tasks: 

• Specify an injection volume of 100 µL.

• For an MS-directed system, enter 227.1 in the Mass A column, 282.1 
in the Mass B column, and 371.2 in the Mass C column. In the 
Fraction Trigger 1 column, enter Mass A. In the Fraction Trigger 2 
column, enter Mass B. In the Fraction Trigger 3 column, enter Mass 
C.

• For a UV-directed system, enter 418 in the Wavelength A column 
and 590 in the Wavelength B column. In the Fraction Trigger 1 
column, enter Wavelength A for a PDA detector or UV1 for a UV 
detector, such as the Waters 2487 dual wavelength absorbance 
detector. In the Fraction Trigger 2 column, enter Wavelength B for a 
PDA detector, or UV2 for an UV detector.

Tip: The Mass and Wavelength columns are for information only, 
unless the corresponding fraction information is entered in the 
Fraction Trigger column.

6. For systems that include a ZMD mass detector, set the instrument’s 
multiplier voltage to 550 V. For systems that include a ZQ mass 
detector, set the multiplier voltage to 500 V. For systems that include a 
3100 mass detector, retain the default gain setting of 1.

7. From the shortcut bar, click FractionLynx > Collection Control, and 
verify that your system is activated. 

To set the FractionLynx method parameters for a system test:

1. In the FractionLynx main window, click Edit FractionLynx method.

2. In the FractionLynx method, click each tab to set the parameters you 
want to define for this fraction collection method (see the Table titled 
“FractionLynx method settings:” on page 2-37.)
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Exception: The FractionLynx method parameters for the UV-based 
system test apply to Waters UV detectors. When using the detectors of 
other manufacturers, the threshold values can differ slightly. They 
might also differ from system to system. Use the values specified in the 
table below as guidelines. 

3. Based on your detector, enter the values specified in the table below.

FractionLynx method settings:

Parameter tab Settings you can specify

General • Set Fraction Collection to On and Peak Type to 
Preparative.

• Select the Max Fractions per injection check box, and 
specify a value of 10.

• Select the Max Tubes per injection check box, and 
specify a value of 10.

• Rinse time = 0.
• Span = 0.5 amu.

Timing • Solvent Front Delay = 0 seconds.
• Split/Collector Delay =  seconds, where x = the split 

collector delay determined earlier.

Volume • Minimum Fraction Width = 3 seconds.
• Maximum Fraction Width = 120 seconds.
• Maximum Tube Fill = 90 percent.
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Tip: Where values are not specified in the table, retain FractionLynx 
method’s defaults.

To collect fractions for the system test:

1. From the shortcut bar, click FractionLynx > Collection Control, and 
verify that your system is activated. 

2. From the MassLynx toolbar, click Start.

FractionLynx method settings based on detector type:

Detector type FractionLynx 
method tab Settings you can specify

2487 UV • MIT = 1000.
• Peak Start = Leading Edge Gradient % 

with a value of 30.
• Terminate Peak = Below Gradient % with 

a value of 60.

PDA PDA • Span = 3 nm.
• MIT = 5,000.
• Peak Start = Leading Edge Gradient % 

with a value of 30.
• Terminate Peak = Below Gradient % with 

a value of 60.

Mass Spec ES+ • ES+ Ion Adducts = 1.
• MIT = 5,000,000.
• Peak Start = Use MIT only.
• Terminate Peak = Use MIT only.

Analog Analog • MIT = 5,000.
• Peak Start = Leading Edge Gradient % 

with a value of 30.
• Terminate Peak = Below Gradient % with 

a value of 60.
2-38 Preparing the System



book.book  Page 39  Wednesday, December 13, 2006  2:53 PM
UV Chromatography Dye Test Results

These chromatograms represent typical results of the dye test. The 
chromatograms show three separate color samples of blue, yellow, and violet 
collected into separate vials labeled 1:16, 1:17, and 1:18 to 1:19.

UV dye test chromatogram: 

This sample was collected using the Waters 996 PDA Detector. The 
wavelength values were put in the sample list, and the fraction triggers were 
set to Wavelength A and B.

• The extracted wavelength shows the correct picture of what was actually 
collected.

• Click Display > Wavelength to input the wavelengths of choice, and then 
click OK to get the extracted wavelengths.

• To extract the spectrum, double-click the peak in the Total Absorbance 
Chromatogram (TAC).
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Actual results can vary if different column sizes, flow rates, and injection 
volumes are used.

MS chromatography dye test results:

The chromatograms above represent typical results of the dye test. The three 
components of the dye mix have been separated and collected into separate 
vials labeled 1:16, 1:17, and 1:18 to 1:19.

The extracted ion shows the correct picture of what was actually collected into 
each vial. Double-click the peak in the Total Ion Chromatogram (TIC) to 
extract the spectrum, and double-click the spectrum of the mass of interest to 
extract the mass chromatograms. Always consider the extracted ion or 
wavelength when troubleshooting as it will give the correct representation of 
what was actually collected.
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Viewing reports

Within the FractionLynx browser, you can view, print, or export results to 
other applications (such as a LIMS system or an Microsoft Excel file) using the 
clipboard or tab-delimited text files. From the MassLynx shortcut bar, click 
FractionLynx > Browser.

FractionLynx creates a report file (*.fpt) when you perform these tasks:

• Use a sample list and select AutoPurify in the Process column and an 
*.flp method in the Parameter column. When starting a sample list, you 
must also select Acquire Sample Data and Auto Process Samples.

• Submit a job using OA Login.

Requirement: For compound targeting, when using OA Login or a sample list, 
you must specify the mass value that you want to search for.

Printing reports

Report schemes (*.frs files) specify the information included in printed 
reports. From the FractionLynx Browser, click File > Report Scheme Settings 
to define the information you want in a printed report. 
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Using the waste detector

By including an additional detector downstream of the fraction collector in an 
AutoPurification system, you can monitor the solvent stream for samples or 
portions of samples not collected by the fraction collector. Waste detectors are 
commonly used to evaluate the efficiency of fraction collection. A waste 
detector trace that shows no evidence of the sample indicates successful 
fraction collection. However, the presence of the sample in the waste stream 
does not necessarily indicate a failed collection. 

The waste detector trace differs from the trigger detector trace. This section 
explains how to use the waste detector trace to monitor the quality of fraction 
collection.

Prerequisite: To monitor the uncollected portions of the peak, you must 
connect a waste detector to the outlet of the fraction collector. Ensure that the 
detector flow cell is designed for the correct flow rate.

Tip: The illustrations in this section depict a single compound eluting from the 
column. If multiple peaks elute and are collected by the waste detector, the 
resulting chromatograms may differ from the illustrations provided in this 
section.
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Expected versus actual collection
The illustration below contains two chromatograms. The upper chromatogram 
displays the trace from the trigger detector, where some of the front and the 
tail of the peak were intentionally not collected. To ensure some of the sample 
was not collected and to more clearly describe the functionality, the collection 
threshold in the FractionLynx method was set artificially high.

The illustration below is a drawing that depicts the expected chromatogram 
from the waste detector, when the front and tail of the peak pass through the 
trigger detector.

Expected collection when the threshold is set too high:

Although the illustration appears to depict two distinct peaks passing through 
the waste detector, it is actually a single peak. When collection starts, the 
collection valve opens and the solvent flow to the waste detector stops. The 
portion of the sample that was not collected remains in the tubing beyond the 
collection valve. Whether or not the sample reaches the waste detector 
depends on three factors:

• Volume of the tubing between the collector valve and the waste detector 

• System flow rate

• Collection threshold

When collection finishes, the tail of the peak that was not collected moves 
through the collection valve and combines with the front of the peak, which 
remained in the tubing during fraction collection. The two portions of the 
sample elute as a single peak in the waste detector.
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Actual collection with correct threshold settings:

The illustration above shows two chromatograms. The upper chromatogram 
depicts the trigger detector trace and the portion of the peak that was 
collected successfully. This example is more representative of an actual 
collection than the example on the previous page. If you magnified the 
baseline of the upper chromatogram, you would notice that a small amount of 
sample was not collected from both the front and tail of the peak, which is not 
unusual.

The lower chromatogram depicts the waste detector trace, and shows a small 
plateau before the waste peak and then the peak itself. The plateau 
corresponds to the small amount of sample that entered the waste detector 
before collection started and the flow to the waste detector stopped. The peak 
corresponds to the pre- and post collections, which combine to form a single 
peak.

In the illustration above, the waste detector was relatively close to the fraction 
collector, so a small amount of the uncollected fraction reached the waste 
detector, resulting in the slight increase in absorbance and the plateau before 
the peak. When the distance, and therefore the volume, between the fraction 
collector and the waste detector is increased, slightly different peak shapes 
can result.
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Monitoring the quality of the fraction collection

When comparing the waste detector trace before and after a collection, the loss 
of the peak’s signal indicates successful collection. You can successfully collect 
a fraction, yet still see a peak in the waste detector.

The illustration below depicts waste chromatograms with and without 
fraction collection. The peak on the left shows the waste detector 
chromatogram when no collection occurred. The peak on the right shows the 
waste detector chromatogram when collection did occur. The right-hand trace 
confirms that some sample was not collected and passed through to the waste 
detector. When you overlay the two chromatograms and compare them to one 
another, it appears that the collection was not successful.

Overlay of waste detector traces with and without collection:

However, when you link the vertical axis and overlay the two chromatograms, 
as shown below, it is difficult to see the waste peak detected when fraction 
collection occurred, compared to when collection did not occur. The inset 
chromatogram, which displays a magnified section of the chromatograms, 
shows a better representation of the relationship between the two 
chromatograms. The retention time delay results from the temporary flow 
stoppage in the tubing between the fraction collector and the waste detector.

Overlay of waste detector traces with and without collection, with the 
vertical axis linked:

No collection Collection

Zoom

No collection

Collection
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Comparing chromatograms with different delay times
Delay times affect the efficiency of fraction collection. To optimize collection, 
you can adjust the delay times in the FractionLynx method, and monitor the 
waste detector chromatograms. The illustration below depicts how delay time 
can affect the efficiency of the collection.

Example: The following illustration depicts five overlaid chromatograms from 
the waste detector. The largest peak is the waste peak with no collection at all. 
During collection, the other four peaks elute as follows: 

• 3 seconds early

• 1 second early

• 1 second late

• At the correct delay time

Effect of delay time on chromatograms:

To see the differences in the chromatograms easily, zoom on the base of the 
peaks (shown at right).

When the delay time is set to the optimal value, the amount of sample that 
passes from the fraction collector to waste is minimal.

No collection

3 seconds early

1 second early 1 second late

Optimal collection

Zoom
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Determining the system dwell volume

System dwell volume is the amount of liquid that resides in the tubing from 
the point where the mobile phase solvents are mixed until they reach the head 
of the column. 

Gradient methods depend on gradual change in the mobile phase 
concentration to separate compounds. By determining the system dwell 
volume, you can program the appropriate hold time at the beginning of a 
gradient method. This ensures consistent chromatography when scaling 
between systems or between columns.

Determine the dwell volume for both the analytical and preparative sides of 
the AutoPurification system. Do the analytical side first. 

Prerequisite: The day before you perform this procedure, prepare a solution of 
acetonitrile with 0.05 mg/mL uracil. This ensures the uracil will be completely 
solubilized when you perform the system dwell volume procedure.

To determine the system dwell volume:

1. Remove the column.

2. Set up the AutoPurification system with acetonitrile as mobile phase A 
and acetonitrile with 0.05 mg/mL uracil as mobile phase B. 

3. Program the analytical method as follows. 

Tip: Use the scaled flow rates appropriate for the selected analytical and 
preparative columns. 

Programming the analytical method: 1_System_Volume

Time Flow %A %B Curve shape

0.00 1.46 100 0

5.00 1.46 100 0 6

5.01 1.46 0 100 1

10.01 1.46 0 100 1

10.02 1.46 100 0 1
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4. Measure the absorbance difference between 100% A and 100% B. 

Example: In the figure below, the absorbance difference between 
100% A and 100% B is 0.7164 AU. 

Example: Measuring absorbance at mid-point:

5. Measure the time at 50% of the absorbance difference.

6. Calculate the time difference between liftoff and the 50% point, and then 
multiply the time difference by the flow rate.

Calculation example: 

Actual time at 50% absorbance = 5.69 min

Programmed time = 5.00 min

Delay time = Actual time – programmed time = 0.69 min

System volume: 0.69 min × 1.5 mL/min = 1.04 mL 

100% asymptotic

Liftoff

50% 
absorbance = 
0.3582 AU

Programmed time 
= 5.00 minutes

5.69 minutes

Total absorbance = 
0.7164 AU
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7. Repeat steps 3 through 6 for the preparative side, programming the 
preparative method using the values in the following table. 

Programming the preparative method: 2_System_Volume

Time Flow %A %B Curve shape

0.00 25 100 0

5.00 25 100 0 6

5.01 25 0 100 1

10.01 25 0 100 1

10.02 25 100 0 1
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3 Maintenance and Troubleshooting
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System maintenance 

See also: MassLynx online Help, FractionLynx online Help, and the 
operator’s guides for the individual modules of the AutoPurification System:

• 3100 Mass Detector Operator’s Guide

• 2545 Binary Gradient Module Operator’s Guide

• System Fluidics Organizer Operator’s Guide

• 2767 Sample Manager, Injector, and Collector Operator’s Guide 

• 2996 PDA Detector Operator’s Guide

• 2420 Evaporative Light Scattering Detector Operator’s Guide

• 2487 Dual Wavelength Absorbance Detector Operator’s Guide

• Fraction Collector III Operator’s Guide
3-2 Maintenance and Troubleshooting



book.book  Page 3  Wednesday, December 13, 2006  2:53 PM
General operating procedures

To keep your system running smoothly, follow the operating procedures and 
guidelines in each system instrument’s documentation.

Spare parts
For spare parts and part numbers, go to http://www.waters.com. Parts not 
listed in the Waters web site are not recommended for customer replacement. 

Contacting Waters Technical Service
If you are located in the USA or Canada, report malfunctions or other 
problems to Waters Technical Service (800 252-4752). If you are located 
anywhere else, phone Waters’ corporate headquarters in Milford, 
Massachusetts (USA), or contact your local Waters subsidiary. Our Web site 
includes phone numbers and e-mail addresses for Waters locations worldwide. 
Go to www.waters.com, and click About Waters > Worldwide Offices. 

However you contact Waters, be prepared to provide the serial number of your 
mass detector and other instruments in the system.
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Troubleshooting and clearing errors

FractionLynx displays three types of errors that can occur in the 
AutoPurification system: 

• Collection system problems

• Fraction collection problems

• Instrument problems

You can view communication errors in the FractionLynx - Collection Control 
window and the MassLynx Inlet Editor. To view communication errors in the 
FractionLynx - Collection Control window, click Overview > System Overview 
> View Status Log. In the Status Log dialog box, a green check mark or red X 
appears next to the system name indicating whether communications are 
working or have failed. Pause the cursor on the symbol to view the status 
message. 

To clear errors in the FractionLynx - Collection Control window:

1. Deactivate the fraction system.

2. Close the FractionLynx - Collection Control window, and then reopen it.

Guideline: If the solutions in these troubleshooting topics do not resolve 
the problem, consider reviewing the fraction file (Fract.txt) that resides 
in the *.raw data directory of your project. The Fract.txt file contains 
values such as threshold settings for triggers, minimum and maximum 
fraction times, and adduct information. Also keep in mind that 
FractionLynx cannot create a fraction file if the file is missing from the 
sample list. 

3. Click the Activate button to activate collection control. 
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Collection system error messages

Collection system error messages and solutions  

Error message Solution

Bed Layout Error! Determine which of these conditions might be 
causing the problem, and then correct it as 
instructed:
• Ensure that you specified the correct bed for each 

fraction collector.
• The bed layout might be corrupt. Re-create the 

bed.

Failed to load Barcode file Determine which of these conditions might be 
causing the problem, and then correct it as 
instructed:
• Create the required bar code file using the 

BarCode Generator, or specify the correct bar code 
file.

• If your access to the file is denied, check the 
permissions on the file, or determine whether 
another user is editing the file.

Collector: 
[CollectorNumber], 
Plate:[PlateNumber]- 
Barcode File [BarcodeFile] 
does not match plate format, 
or does not exist.

Load the bar code file into the BarCode Generator. 
Review the file’s format to be sure that it is the same 
as the plate format you are using.

Need to reset beds after 
Emergency Collection in 
Injection Mapped Reserved 
Vessels mode.

Reset all beds for this system. 
Rule: You cannot resume normal collection from the 
injection vial after running an emergency collection 
from that vial in Injection Mapped Reserved Vessels 
mode.
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Cannot reset the plates on 
the current collector.

For safety reasons, correct this problem in one of two 
ways:
• Wait until the collection moves to another 

collector.
• Pause the sample list, wait until the sample run 

finishes, and then reset the plates and beds.
Rule: When running samples in mapped mode, such 
as for one-to-one collection, you cannot reset the 
plates. Pause the sample list, wait for the run to 
finish, and then reset the beds. 

The tube has zero volume or 
the max tube fill is 0%.

Determine which of these conditions might be 
causing the problem, and then correct it as 
instructed:
• The collection tube volume is 0 μL. Use the Bed 

Layout Editor to set the volume of the tube on the 
plate.

• In the FractionLynx method, specify a value for 
Max tube fill greater than 0%.

Fraction System, Comms: 
Failure, Check connections 
and settings. Device, Not 
Initialized, Bed not loaded.

In the FractionLynx - Collection Control window, 
review the Status Log to determine the nature of the 
problem.

Collection system error messages and solutions (Continued) 

Error message Solution
3-6 Maintenance and Troubleshooting
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Fraction collection problems

Fraction collection problems and solutions

Problem Solution

Identified wrong mass. Review the sample list to ensure that the correct 
monoisotopic mass was specified, and ensure that the 
correct sample was injected at the beginning of a run. 
If you reuse a sample list, you may inadvertently 
specify the wrong sample, mass of interest, or set the 
wrong triggers.
From the MassLynx Main window, click Instrument 
> MS Method. In the Mass Spec Method, check the 
scan settings.

Incorrect trigger entries. If the compound of interest was not collected, in the 
sample list, note the Fraction Trigger column and 
ensure the mass of interest is selected.
Check the wavelength settings for your detector type:
• For a 996 or 2996 PDA Detector, you must specify 

a numerical value in the Wavelength column. In 
the Fraction Trigger column, select wavelength A, 
B, C, and so on.

• For a Waters 2487 Detector, specify the 
wavelength in the Inlet Editor. In the Fraction 
Trigger column of the sample list, select UV1 for 
Channel A, and UV2 for Channel B.

An error message notifies 
you that you are outside the 
calibration range. 

The MS scan speed is too fast or too slow. Adjust your 
scan speed to stay within the calibration range.
See also: Waters 3100 Mass Detector Operator's 
Guide.
Fraction collection problems 3-7
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Target mass was not in the 
MS Scan range.

If the compound of interest was not collected, ensure 
that the mass spectrometer method has a range that 
includes the target mass. For example, if a target 
mass is 253, and the mass scan range is 300 to 500, 
the fraction is not collected.
From the MassLynx Main window, click Instrument 
> MS Method. In the Mass Spec Method, check the 
scan settings.

Not collecting the target 
mass of interest.

In the Tune window, examine the cone voltage and 
compound ionization parameters.
Set the cone voltage low (30) to prevent too much 
fragmentation.

Fraction collection problems and solutions (Continued)

Problem Solution
3-8 Maintenance and Troubleshooting
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Instrument problems

Instrument problems and solutions

Problem Solution

Error initializing [selector] 
valve.

Determine which of these conditions might be 
causing the problem with the selector valve, and then 
correct it as instructed:
• Ensure the communication port is set correctly. 

Ensure cables are correctly and securely attached.
• Change the control mode on the selector valve 

from local to remote.

Error moving the selector 
valve to [Position].

Determine which of these conditions might be 
causing the problem, and then correct it as 
instructed:
• Ensure communication port is set correctly and 

ensure cables are correctly and securely attached.
• If the error occurred while moving the selector 

valve, reset it, and then reactivate FractionLynx.
• Ensure you are using the correct type of valve for 

the configuration (analytical, preparative, or 
selector).

Failed to communicate with 
the Waters 2767: 
Communication Fault.

Ensure the instrument’s communications settings 
are correct, that cables are secure in their proper 
terminals, and that the 2767 Sample Manager’s 
on/off switch is set to On.

Waters 2767 Fraction 
Collector: [ReportedError].

See the Waters 2767 Sample Manager, Collector 
Installation and Maintenance Guide for details. 
From the FractionLynx Main window, deactivate, 
and then reactivate FractionLynx.
Instrument problems 3-9
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Waters F C II/III: Error 
during initialization.
Comms Error

When any of these errors occur on the Waters 
Fraction Collector II/III, determine whether these 
conditions exist:
• Cables are correctly and securely connected, and 

the on/off switch is set to On.
• Communications settings are correctly specified.
• Ensure cables are correctly and securely attached.
• Ensure the on/off switch is set to On.

Error occurred entering idle 
state.

You attempted to close the fraction collector valve on 
the Waters Fraction Collector II/III. Inspect the 
cables making sure they are correctly and securely 
connected.

Error moving to vessel 
Error moving to rinse 
position
Error moving home

If these errors occur while trying to move the Waters 
2767 Sample Manager to the home position or rinse 
position, see the Inlet Method window for status 
details.
If these errors occur while trying to move the Waters 
2767 Sample Manager to the Waters Fraction 
Collector II/III home position, check the cables and 
power. 

Error during move Inspect the cables for improper or poor connection. 
Power-on the Waters Fraction Collector II/III. 
Ensure that the fraction collector is not obstructed. 

This instrument is in the 
SET state. This instrument 
has to be returned to the 
MENU state manually 
before initialization can be 
completed. Reset comms 
when instrument has been 
returned to MENU.

Use the control panel on the Waters Fraction 
Collector II/III to return to the Main menu, and then 
try again.

Instrument problems and solutions (Continued)

Problem Solution
3-10 Maintenance and Troubleshooting
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2545 multi-module instrument problems

The error messages might involve the 2545 Binary Gradient Module or other 
instruments (1525, 600, SFO, or 1500). 

Multi-module instrument error messages and solutions

Error message Solution

Please reset 
communications

Any time you reconfigure a set of controlled 
instruments, you must reset communications.
To reset communications, from the Inlet Method 
window, click LC > Reset Communications. 
Close the Inlet Method window, and then reopen it to 
apply the new configuration to the additional status 
view.

Message (m) Check the operator’s guide for the particular 
hardware module for corrective action instructions.
Note: (m) indicates the name of the instrument that 
generated this error message. 

Module is in failed state (m) The instrument, indicated by (m), experienced an 
error and is no longer functioning.
Try resetting communications. From the Inlet 
Method window, click LC > Reset Communications. 
If this does not restore the green OK indicator, refer 
to the instrument’s operator’s guide.

Failed to read module status 
(m)

Determine whether these items on the 
autopurification device (m) are correct:
• The on/off switch is set to On.
• Cables are connected securely and correctly.
• Configuration is correct.
• Try to scan 2545 binary gradient modules in the 

Inlet Method window.
• Try to scan from the Inlet Method > Inlet > Modify 

Instrument Method > Configure Waters Pump 
Control Modules.
2545 multi-module instrument problems 3-11
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Peak detection problems

Peak detection problems and solutions

Problem Solution

One or both 
detectors did 
not detect a 
peak.

If the mass spectrometer did not detect a peak, confirm the 
condition of these mass spectrometer components and settings:
• Ensure that the sample ionizes in the selected ionization 

mode.
• Ensure there is flow to the detector. Tee and/or the probe must 

not be blocked. Look for flooding in the mass spectrometer and 
ensure flow emanates from the tip of the probe.

• Fittings do not leak.
• The polarity parameter settings (+ and −) must be correct.
• Mass spectrometer cone must be clean.
• Try injecting a known compound such as setup solution or the 

dye standards.
If the UV detector did not detect a peak, confirm the condition of 
these UV detector components and settings:
• Sample contains an UV chromophore.
• Lamp must be turned on and working properly.
• Tee must not be blocked.
• Wavelength must be set correctly (for example, at 240 nm, not 

254) in the Inlet method.
If both the UV detector and mass spectrometer fail to detect 
peaks, confirm the condition of these components and settings:
• Makeup pump must be running and pumping flow.
• Sample and solvent must be flowing to both detectors.
• Vial must contain the correct sample for the injection.
• The injector Z position must be set correctly.
3-12 Maintenance and Troubleshooting
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One or both 
detectors did 
not detect a 
peak. 
(continued)

If the ELSD detector did not detect a peak, confirm the condition 
of these components and settings:
• Lamp must be turned on and working properly.
• Tee must not be blocked.
• Gas must be flowing freely to the nebulizer and the nebulizer 

and/or drift tube must be clean.

Poor peak shape 
due to 
overloaded or 
degraded 
column.

Decrease injection volume.
Decrease concentration of solubilized sample. 
Replace the column.
Check the solvents and ensure that the mobile phase is composed 
of high-quality HPLC water and organic solvents. 

Peak detection problems and solutions (Continued)

Problem Solution
Peak detection problems 3-13
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A Safety Advisories

Waters instruments display hazard symbols designed to alert you to the 
hidden dangers of operating and maintaining the instruments. Their 
corresponding user guides also include the hazard symbols, with 
accompanying text statements describing the hazards and telling you 
how to avoid them. This appendix presents all the safety symbols and 
statements that apply to the entire line of Waters products.

Contents

Topic Page

Warning symbols A-2

Caution symbol A-6

Warnings that apply to all Waters instruments A-7

Electrical and handling symbols A-14
A-1
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Warning symbols

Warning symbols alert you to the risk of death, injury, or seriously adverse 
physiological reactions associated with an instrument’s use or misuse. Heed 
all warnings when you install, repair, and operate Waters instruments. 
Waters assumes no liability for the failure of those who install, repair, or 
operate its instruments to comply with any safety precaution.

Task-specific hazard warnings
The following warning symbols alert you to risks that can arise when you 
operate or maintain an instrument or instrument component. Such risks 
include burn injuries, electric shocks, ultraviolet radiation exposures, and 
others. 

When the following symbols appear in a manual’s narratives or procedures, 
their accompanying text identifies the specific risk and explains how to avoid 
it.

Warning: (General risk of danger. When this symbol appears on an 
instrument, consult the instrument’s user documentation for 
important safety-related information before you use the instrument.)

Warning:  (Risk of burn injury from contacting hot surfaces.)

Warning: (Risk of electric shock.)

Warning: (Risk of fire.)

Warning: (Risk of needle puncture.)

Warning: (Risk of injury caused by moving machinery.)

Warning: (Risk of exposure to ultraviolet radiation.)

Warning: (Risk of contacting corrosive substances.)
A-2 Safety Advisories
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Warnings that apply to particular instruments, instrument 
components, and sample types

The following warnings can appear in the user manuals of particular 
instruments and on labels affixed to them or their component parts.

Burst warning

This warning applies to Waters instruments fitted with nonmetallic tubing.

Warning: (Risk of exposure to a toxic substance.)

Warning: (Risk of personal exposure to laser radiation.)

Warning: (Risk of exposure to biological agents that can pose a serious 
health threat.)

Warning: Pressurized nonmetallic, or polymer, tubing can burst. 
Observe these precautions when working around such tubing:
• Wear eye protection.
• Extinguish all nearby flames.
• Do not use tubing that is, or has been, stressed or kinked.
• Do not expose nonmetallic tubing to incompatible compounds like 

tetrahydrofuran (THF) and nitric or sulfuric acids.
• Be aware that some compounds, like methylene chloride and 

dimethyl sulfoxide, can cause nonmetallic tubing to swell, which 
significantly reduces the pressure at which the tubing can rupture.
Warning symbols A-3
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Mass spectrometer flammable solvents warning

This warning applies to instruments operated with flammable solvents.

Mass spectrometer shock hazard

This warning applies to all Waters mass spectrometers.

This warning applies to certain instruments when they are in Operate mode.

Warning: Where significant quantities of flammable solvents are 
involved, a continuous flow of nitrogen into the ion source is required 
to prevent possible ignition in that enclosed space. 
Ensure that the nitrogen supply pressure never falls below 400 kPa 
(4 bar, 58 psi) during an analysis in which flammable solvents are 
used. Also ensure a gas-fail connection is connected to the HPLC 
system so that the LC solvent flow stops if the nitrogen supply fails.

Warning: To avoid electric shock, do not remove the mass 
spectrometer’s protective panels. The components they cover are not 
user-serviceable.

Warning: High voltages can be present at certain external surfaces of 
the mass spectrometer when the instrument is in Operate mode. To 
avoid non-lethal electric shock, make sure the instrument is in 
Standby mode before touching areas marked with this high voltage 
warning symbol.
A-4 Safety Advisories
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Biohazard warning

This warning applies to Waters instruments that can be used to process 
material that might contain biohazards: substances that contain biological 
agents capable of producing harmful effects in humans.

Chemical hazard warning

This warning applies to Waters instruments that can process corrosive, toxic, 
flammable, or other types of hazardous material.

Warning: Waters’ instruments and software can be used to analyze or 
process potentially infectious human-sourced products, inactivated 
microorganisms, and other biological materials. To avoid infection 
with these agents, assume that all biological fluids are infectious, 
observe good laboratory practices, and consult your organization’s 
biohazard safety representative regarding their proper use and 
handling. Specific precautions appear in the latest edition of the US 
National Institutes of Health (NIH) publication, Biosafety in 
Microbiological and Biomedical Laboratories (BMBL).

Warning: Waters instruments can be used to analyze or 
process potentially hazardous substances. To avoid injury 
with any of these materials, familiarize yourself with the 
materials and their hazards, observe Good Laboratory 
Practices (GLP), and consult your organization’s safety 
representative regarding proper use and handling. 
Guidelines are provided in the latest edition of the 
National Research Council's publication, Prudent Practices 
in the Laboratory: Handling and Disposal of Chemicals.
Warning symbols A-5
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Caution symbol

The caution symbol signifies that an instrument’s use or misuse can damage 
the instrument or compromise a sample’s integrity. The following symbol and 
its associated statement are typical of the kind that alert you to the risk of 
damaging the instrument or sample.

Caution: To prevent static charges and resultant circuit damage, do 
not remove the covers that protect integrated circuit chips.
A-6 Safety Advisories
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Warnings that apply to all Waters instruments

When operating this device, follow standard quality control procedures and 
the the equipment guidelines in this section.

Attention: Changes or modifications to this unit not expressly approved by 
the party responsible for compliance could void the user’s authority to operate 
the equipment.

Important: Toute modification sur cette unité n’ayant pas été expressément 
approuvée par l’autorité responsable de la conformité à la réglementation 
peut annuler le droit de l’utilisateur à exploiter l’équipement.

Achtung: Jedwede Änderungen oder Modifikationen an dem Gerät ohne die 
ausdrückliche Genehmigung der für die ordnungsgemäße Funktion-
stüchtigkeit verantwortlichen Personen kann zum Entzug der 
Bedienungsbefugnis des Systems führen.

Avvertenza: eventuali modifiche o alterazioni apportate a questa unità e 
non espressamente approvate da un ente responsabile per la conformità 
annulleranno l’autorità dell’utente ad operare l’apparecchiatura.

Atencion: cualquier cambio o modificación efectuado en esta unidad que no 
haya sido expresamente aprobado por la parte responsable del cumplimiento 
puede anular la autorización del usuario para utilizar el equipo.
Warnings that apply to all Waters instruments A-7
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Warning: Use caution when working with any polymer tubing under 
pressure:
• Always wear eye protection when near pressurized polymer tubing.
• Extinguish all nearby flames.
• Do not use tubing that has been severely stressed or kinked.
• Do not use nonmetallic tubing with tetrahydrofuran (THF) or concentrated 

nitric or sulfuric acids.
• Be aware that methylene chloride and dimethyl sulfoxide cause 

nonmetallic tubing to swell, which greatly reduces the rupture pressure of 
the tubing.

Attention: Manipulez les tubes en polymère sous pression avec precaution:
• Portez systématiquement des lunettes de protection lorsque vous vous 

trouvez à proximité de tubes en polymère pressurisés.
• Eteignez toute flamme se trouvant à proximité de l’instrument.
• Evitez d'utiliser des tubes sévèrement déformés ou endommagés.
• Evitez d'utiliser des tubes non métalliques avec du tétrahydrofurane 

(THF) ou de l'acide sulfurique ou nitrique concentré.
• Sachez que le chlorure de méthylène et le diméthylesulfoxyde entraînent le 

gonflement des tuyaux non métalliques, ce qui réduit considérablement 
leur pression de rupture.

Vorsicht: Bei der Arbeit mit Polymerschläuchen unter Druck ist besondere 
Vorsicht angebracht:
• In der Nähe von unter Druck stehenden Polymerschläuchen stets 

Schutzbrille tragen.
• Alle offenen Flammen in der Nähe löschen.
• Keine Schläuche verwenden, die stark geknickt oder überbeansprucht 

sind.
• Nichtmetallische Schläuche nicht für Tetrahydrofuran (THF) oder 

konzentrierte Salpeter- oder Schwefelsäure verwenden.
• Durch Methylenchlorid und Dimethylsulfoxid können nichtmetallische 

Schläuche quellen; dadurch wird der Berstdruck des Schlauches erheblich 
reduziert.
A-8 Safety Advisories
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Attenzione: prestare attenzione durante l’utilizzo dei tubi di polimero 
pressurizzati:
• Indossare sempre occhiali da lavoro protettivi nei pressi di tubi di polimero 

pressurizzati.
• Estinguere ogni fonte di ignizione circostante.
• Non utilizzare tubi soggetti che hanno subito sollecitazioni eccessive o son 

stati incurvati.
• Non utilizzare tubi non metallici con tetraidrofurano (THF) o acido 

solforico o nitrico concentrato.
• Tenere presente che il cloruro di metilene e il dimetilsolfossido provocano 

rigonfiamento nei tubi non metallici, riducendo notevolmente la resistenza 
alla rottura dei tubi stessi.

Advertencia: se recomienda precaución cuando se trabaje con tubos de 
polímero sometidos a presión:
• El usuario deberá protegerse siempre los ojos cuando trabaje cerca de 

tubos de polímero sometidos a presión.
• Si hubiera alguna llama las proximidades.
• No se debe trabajar con tubos que se hayan doblado o sometido a altas 

presiones.
• Es necesario utilizar tubos de metal cuando se trabaje con 

tetrahidrofurano (THF) o ácidos nítrico o sulfúrico concentrados.
• Hay que tener en cuenta que el cloruro de metileno y el sulfóxido de 

dimetilo dilatan los tubos no metálicos, lo que reduce la presión de ruptura 
de los tubos.
Warnings that apply to all Waters instruments A-9
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Warning: The user shall be made aware that if the equipment is used in a 
manner not specified by the manufacturer, the protection provided by the 
equipment may be impaired.

Attention: L’utilisateur doit être informé que si le matériel est utilisé d’une 
façon non spécifiée par le fabricant, la protection assurée par le matériel 
risque d’être défectueuses.

Vorsicht: Der Benutzer wird darauf aufmerksam gemacht, dass bei unsach-
gemäßer Verwenddung des Gerätes unter Umständen nicht ordnungsgemäß 
funktionieren.

Attenzione: l’utente deve essere al corrente del fatto che, se l’apparecchia-
tura viene usta in un modo specificato dal produttore, la protezione fornita 
dall’apparecchiatura potrà essere invalidata.

Advertencia: el usuario deberá saber que si el equipo se utiliza de forma 
distinta a la especificada por el fabricante, las medidas de protección del 
equipo podrían ser insuficientes.
Warnings that apply to all Waters instruments A-11
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Warning: To protect against fire hazard, replace fuses with those of the same 
type and rating.

Attention: Remplacez toujours les fusibles par d’autres du même type et de 
la même puissance afin d’éviter tout risque d’incendie.

Vorsicht: Zum Schutz gegen Feuergefahr die Sicherungen nur mit 
Sicherungen des gleichen Typs und Nennwertes ersetzen.

Attenzione: per una buona protezione contro i rischi di incendio, sostituire i 
fusibili con altri dello stesso tipo e amperaggio.

Advertencia: sustituya los fusibles por otros del mismo tipo y características 
para evitar el riesgo de incendio.
A-12 Safety Advisories
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Warning: To avoid possible electrical shock, disconnect the power cord before 
servicing the instrument.

Attention: Afin d’éviter toute possibilité de commotion électrique, 
débranchez le cordon d’alimentation de la prise avant d’effectuer la mainte-
nance de l’instrument.

Vorsicht: Zur Vermeidung von Stromschlägen sollte das Gerät vor der 
Wartung vom Netz getrennt werden.

Attenzione: per evitare il rischio di scossa elettrica, scollegare il cavo di 
alimentazione prima di svolgere la manutenzione dello strumento.

Precaución: para evitar descargas eléctricas, desenchufe el cable de alimen-
tación del instrumento antes de realizar cualquier reparación.
Warnings that apply to all Waters instruments A-13
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Electrical and handling symbols

Electrical symbols
These can appear in instrument user manuals and on the instrument’s front 
or rear panels.

Electrical power on

Electrical power off

Standby

Direct current

Alternating current

Protective conductor terminal

Frame, or chassis, terminal

Fuse

Recycle symbol: Do not dispose in municipal waste.
A-14 Safety Advisories
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Handling symbols
These handling symbols and their associated text can appear on labels affixed 
to the outer packaging of Waters instrument and component shipments.

Keep upright!

Keep dry!

Fragile!

Use no hooks!
Warnings that apply to all Waters instruments A-15
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